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1 AWR Corp.’s Microwave Office

AWR gives students a free license to the full Microwave Office (MWO) suite.  You just have to renew it every 120 days, but you can keep using it as long as you’re a student or staff at a university.  Register and download the software here (it only runs in Windows, or on a Windows partition or emulator on a Mac):

https://awrcorp.com/register/customer.aspx?univ
...AWR will then send you a license file.

Separately, you should also go to this web page and register for their university tech support (you can submit questions and they will answer them, even though it’s free):

http://univ.awrcorp.com/registration
Bookmark this web page however – it leads straight to University Support and has all the getting started links:

http://univ.awrcorp.com
1.1   What is Microwave Office?

Microwave Office is a suite of CAD tools for RF electronics.  The main tool is basically a SPICE engine at its core, but it has S-parameter analysis and a user interface with additional add-on tools that make it convenient to do RF circuit design.  Some of these add-on tools include impedance matching utilities and finite element electromagnetic simulators.  AWR also sells a different suite of tools called Analog Office (marketing people sometimes make things more confusing than they really need to be).

Here’s something from the univ.awrcorp.com site (click on “Solutions”) FAQ site:

http://univ.awrcorp.com/forums/163959-solutions
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Also, here was an answer when I asked a follow up question:

“The real difference between Analog Office and Microwave Office deals with the foundry design kits used.  For example Microwave Office is used for microwave boards and GaAs IC designs, while Analog Office will be used for silicon IC design.  With the exception of circuit extraction, the actual tools used will be the same.

Many of the tools found in the installation directory require additional license features which is why you can't run them when you're in MWO.

In terms of simulators, many of the simulators have the same core capabilities and only differ at the fringes.  For example, you can use APLAC transient for most applications that you can use HSPICE transient for but there are applications, such as using digital part libraries in signal integrity applications, where only HSPICE can be used.  Because MWO is used in these applications, AWR resells HSPICE.

In general, you should be able to use the APLAC capabilities you have access to, to solve your simulation problems.”

1.1.1   EM Simulation:  Axiem and Analyst

The AWR Design Environment has two electromagnetic simulators.  They first had Axiem which is a planar simulator (AWR calls it a “3D planar EM simulator).  Then in 2009, they bought STAAR Corp.’s  Analyst simulator, which is a 3D FEM simulator with parallelization tools.  STAAR was founded in ’97 and came out of Fermi Lab (Dr. John DeFord.  He had joined MSC in ’94 and developed MicrowaveLab which was a competitor to Ansoft’s HFSS product.  Microwave Lab got bought by Ansoft in ’96 and incorporated into Ansoft’s HFSS tool.  He went with Ansoft, but then left and started STAAR, where he developed Analyst.).

Basically, Analyst knows how to use either shared memory or distributed memory (clusters of workstations) to optimally parallelize its FEM calculations.  AWR got Analyst completely integrated into the AWR Design Environment at the end of 2012:

http://www.awrcorp.com/news/article/awr-introduces-analyst
...whereas Axiem had been introduced in 2007:

http://www.awrcorp.com/news/article/awr-showcases-breakthrough-axiem-technology-eumw
MWO has an older simulator in its suite too, called EM Sight, but I think Axiem effectively replaced it.

Analyst is basically a complement to Axiem, which is AWR’s planar simulator.

For EE142, the Axiem and/or Analyst electromagnetic simulators aren’t used, but if you download MWO, Axiem and Analyst are part of the installation and the student version of MWO does allow them to run.  In EE142, we only use circuit simulators, albeit ones with RF features such as Smith Charts, harmonic balance, etc.

1.2   Getting Help and University Support

AWR’s website has a Knowledge Base, and you don’t need a password to get to it:

https://awrcorp.com/download/faq/english/start.aspx
Even though I downloaded a university license, I found that the AWR web site lets me submit requests for technical help.

There is also a separate page on the AWR site for University Support.  Click on the tab labeled Submit a Request to send a question to tech support.

http://univ.awrcorp.com
It says here, they’ll give tech support, even though students get the software for free.  I tried it and it works, they really will answer questions:
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Getting Started Guide > Introducing the AWR Design Environment

Brev

AWR Proprietary

Chapter 1. Introducing the AWR Design Environment

Welcome to the AWR Design Environment™ suite!

The AWR® Design Environment (AWRDE) suite comprises three powerful tools that can be used together to create
an integrated system and RF or analog design environment: Visual System Simulator™ (VSS), Microwave Officc®
(MWO), and Analog Office® (AO) software. These powerful tools are fully integrated in the AWR Design
Environment suite and allow you to incorporate circuit designs into system designs without leaving the AWR Design
Environment.

VSS software cnables you to design and analyze end-to-end communication systems. You can design systems
composed of modulated signals, encoding schemes, channel blocks and system level performance measurements.
You can perform simulations using VSS's predefined transmitters and receivers, or you can build customized
transmitters and receivers from basic blocks. Based on your analysis needs, you can display BER curves, ACPR
‘measurements, constellations, and power spectrums, to name a few. VSS provides a real-time tuncr that allows you
to tunc the designs and then sce your changes immediately in the data display.

Microwave Office and Analog Office software cnables you to design circuits composed of schematics and
clectromagnetic (EM) structures from an extensive cloctrical model database, and then gencrate layout
representations of these designs. You can perform simulations using one of AWR's simulation cngines -- a lincar
simulator. an advanced harmonic balance simulator for nonlincar frequency-domain simulation and analysis, a 3D-
planar EM simulator (the EMSight™ tool), the APLAC simulators, or an optional HSPICE simulator -- and display
the output in a wide variety of graphical forms based on your analysis needs. You can then fun or optimize the
designs and your changes are automatically and immediately reflected in the layout.

Analog Office provides a single environment to fully interact with a comprehensive and powerful sct of integrated
tools for top-down and front-to-back analog and RFIC design.

The toolset spans the entire IC design flow, from system-level to circuit-level design and verification, including
design entry and schematic capture, time- and froquency-domain simulation and analysis, physical layout with
automated device-level place and route and integrated design rule checker (DRC), 3D full field solver-based
extraction with industry gold standard high-spoed extraction technology from OEA International, and a
comprehensive sct of waveform display and analysis capabilitics supporting complex RF measurcments.

‘OBJECT ORIENTED TECHNOLOGY

At the core of the AWR Design Environment capability is advanced object-oriented technology. This technology
results in software that is compact, fast, reliable, and casily enhanced with new technology as it becomes available.

About This Guide

‘This Getting Started Guide is designed to get you up and running quickly in the AWRDE by demonstrating MWO,
VSS. or AO capabilities through working cxamples.




AWR’s web page for a university forum here, and it has links to university-type videos:

http://web.awrcorp.com/Usa/Support/AWR-University-Forum/
1.2.1   Documentation Inside of the Microwave Office

The basic design environment for all of AWR’s tools (AWRDE – AWR Design Environment) looks like this.  It has the notion of a project, just like many CAD tools.  However, you can only have one project open at a time.  If you right-click on any of the document catagories in the project manager tree, you can get a feel for how things work: 
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2.4. Configuring Program File Locations

By default, the AWRDE looks for files and folders in specific dircctories. You can change these default dircctorics to accommodate roaming users.
workgroups, multi-version installs, test machines and show machincs.

To view the location of the dircctorics and files that the AWRDE uses, choose Help > Show Files/Directories to display the Dircctorics dialog box.
The AWRDE uses three primary base locations:

« application - the AWRDE installation dircctory
+ appdatacommon - items common to all user accounts
+ appdatauser - items specific to a single user

The installation directory is user-specificd during program installation. The location of the appda tacommon and appdatauser directories is determined
by calling the Windows SHGetFolderPath API. An administrator can sct the physical location of these directories. The default locations on Windows
‘machines arc:

application:
64-bit operating systems: C: \ Program Files (x86)\AWR\AWRDE\[version number]

32-bit operating systems: C: \ Program Files\AWR\AWRDE\ [version number]
appdatacommon:

‘Windows 7/Windows Vista: C: \ Programbata\aWR\Design Environment)\[version number]
‘Windows XP:

:\Documents and Settings\All Users\Application Data\AWR\Design Environment

appdatauser:

‘Windows 7/Windows Vista: C: \Users\ [username] \AppData\Local\aWR\Design Environment\[version number]

‘Windows XP: C: \Documents and Settings\[username]\Local Settings\Application Data\AWR\Design Environment

A fourth virtual location, appda ta, is st to cither appda tacommon or appda tauser depending on a configuration setting. (Sce “WORKGROUP
(default false)”). All other subdircctories, with the cxception of projects are under onc of the three primary dircctorics.

2.4.1. Searching mwvoffice. ini

A search is performed for the mwoffice. ini file in the following locations:

1. the appdatauser version specific directory

2. the appdatacommon version generic directory

3. the application directory

4. Tf not found, this file is created in the appdatacommon directory.

The first location in which the file is found is the location that is used.

2.4.2. Searching user. ini




Look at Help menu, there’s a Getting Started guide:
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1.2.2   On-line Knowledge Base, Videos and Training Materials

Help can also be found in the AWR on-line Knowledge Base:

www.awrcorp.com/download/kb.aspx
There’s also a web site for AWR television:

http://www.awr.tv/Downloads/
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If you scroll down, you can see the introductory ones, under University videos:
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On the AWR support site, there are some Training Modules which include video, slides and exercises (if you download the MySpeed product from Enounce, www.enounce.com, you can listen to videos at high speed):
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Before you read the rest of this cheatsheet, you should watch those 3 videos.

Those videos teach the basics of getting around in MWO.  This cheatsheet is tips and tricks beyond those basics.

2   Setting Up for AWR Projects

I created this directory to keep all my MWO projects:

C:\Users\aflynn\data\AWRwork

...and a directory under that for log files created by MWO

C:\Users\aflynn\data\AWRwork\logs

Then from the MWO menu bar, choose:

Options -> Environment Options

...got this pop-up window and browsed to the above directories to set them for Default Designs and Logs
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You have to close MWO and restart for new default locations to take effect.

AWR project files are .emp files.  Here I added a schematic sheet to a new project (right click in the Project Browser on Circuit Schematics and select New Schematic):

Then do Save Project and the Save Project browser should open at the new AWRwork directory just created.  When you give your project a name, MWO will add a .emp extension. 

The AWRwork directory now gets updated with a new folder called DATA_SETS and the AWRwork directory also gets two new files:

filename.emp – the project file

filename.vin – a file that keeps the settings for how that project had its windows laid out when it was last closed

2.1   Templates for Projects and for Measurements

After you work with MWO for awhile an organization of schematics and graphs you like, you can save your project out as a template.

Microwave Office also has templates to help save time.  You can save a project as a template:

File -> Save Project As 

...and choose Template

Actually, you should set up a sub-directory inside your working directory, called MyTemplates and store your different project template files there.

A saved template file will have the name of the project, but with a .emt extension.  The template file keeps the format and any project options which you had set in the project, but doesn’t save any specific data.

You can also create Measurement Templates.  Info is in Chapter 7 of the Help:
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2.2 Environment Options

You can set up your environment options to point to the project template you just created.  From the MWO’s Options menu, choose:

Options -> Environment Options

Click on the File Locations tab.   Then you can set up your AWRDE environment to point to your working directory and you can also set it up to point to the project template in the sub-directory you just created (MyTemplates).  All the things you set up in this Enviroment Options dialog box are good for any project you open in the AWRDE gui.

Another useful thing to set up is the Autosave feature on this Project tab shown below in the Environment Options window.  Check the box for Autosave and also check the box for Save Revisions (you can keep the last 6, say, copies of your project).
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3 Importing .s2p Files into MWO

If you’ve save an .s2p file from a network analyzer, you can import it into MWO and plot the S-parameters.

Import that data file into MWO by right-clicking on the project tree document folder named Data Files and selecting Import Data File, and then give it a name.  Let’s call our imported S-parameter data file, MY_INDUCTOR.  Presumably, we had just measured an inductor, say, shunted to ground, on our network analyzer and saved its S-parameter traces out to this .s2p file.

3.1 Plotting S-Params Directly From Data Files

If you now have a data file named MY_INDUCTOR then you can create a new graph (right-click on the project tree’s Graphs document folder and select New Graph).  Then on the new graph itself, right-click and select Add Measurement, and pick say, S11 in LogMag (dB) format.  Unlike in some CAD tools, you didn’t have to create a sub-circuit element and add that sub-circuit element to a schematic in order to plot its data, you can just plot data-file content directly. 

Click the lightning bolt icon to update the graph object with MY_INDUCTOR’s S11 (dB) data.

3.2   Touchstone and .s2p File Format

You can look at the text content any data file you’ve imported, by simply double-clicking on the document in the project tree.  Touchstone format is an industry standard, which is just an ASCII format.  It’s often used for S-params as an SnP file (.s2p file extension for 2-port S-params), but can also contain Z-parameter or Y-parameter data.

Exclamation marks are used to denote comment lines.  The # character starts the options line.  The option line tells what’s in the file.  Below, “Hz” says the first column is frequency in Hz.  “S” means the data is S parameter data.  “dB” means the data is decibel-angle (the colum after frequency is decibel = 20 log_10|...| (magnitude) and the column after that is angle in degrees.  The “R 50” says that the reference system impedance is 50 ohms.  The SOLT2(ON) string means that measurement was taken with a short-open-load-thru 2-port calibration and calibration error corrections was on:

[image: image15.png]



The data is not necessarily always saved by the network analyzer in decibel-angle format.  In the screenshot below, “RI” says it was saved in real part and imaginary part format (this was a Smith chart that was saved).  

On the network analyzer, when you hit the Save button and then use the soft keys to save a .s2p file, if the display is not in dB, (i.e. it’s in Smith chart display mode), the file will by default get saved in real-imaginary format.  There is a sub-menu of soft keys where you can pick to save it in a different format.  For example, another possible option that can show up in a Touchstone file is “MA” which means the data was saved in magnitude-angle format.  (So columns of negative numbers can be dB format or real format, but they obviously can’t be magnitude format.)
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When you define sweeping (frequency, power, ctc.), the Add/Modify Measurement dialog box controls how the swept
analysis data displays.

For information on swept variable analysis, see “Swept Parameter Analysis ™.
7.2.8. Plotting One Measurement vs. Another Measurement

You can plot one measurement versus another measurement. Typical measurements have an input sweep on the x-axis
(frequency, input power, ctc.). If you want to put a measurement (for cxample, output power) on the x-axis, you can
use the PlotVs measurement in the Data measurement category. See the MWO/AO Measurement Catalog for more
information about this measurement.

7.2.9. Single Source vs. Template Measurements

Template measurements are MWO/AO measurements you create by choosing All Sources as the Data Source Name
in the Add Measurement dialog box. A template measurement creates a measurement for cach data source that is added
to the projoct. When a data source is removed from the project, the measurements for the source that were created
from measurcment templates arc also removed. Measurement templates provide a method for specifying a particular
‘measurement that s to be made for cach of the data sources in the project, without creating individual measurements
for cach data source.

A measurement that is associated with a particular data source is a single source measurement. Single source
‘measurements are created by sclocting the name of the associated data source as the Data Source Name in the Add
Measurement dialog bos. Since single source measurements reference a particular data source, if the data source is
deleted or renamed, the measurement gencrates an crror.

7.2.10. Using Project Templates with Template Measurements

You can use project templates to save options, LPFs, artwork cells, design notes, global definitions, frequency, graph,
and measurement information for a particular project for use in other projects or for comparison purposes. When you -





3.3   E5071C Network Analyzer .s2p File Format

You can, from home, go online to the Agilent web site and look at the same Help files that will come up on the actual network analyzers in the lab.  Just go to the agilent web site, type in E5071C, click on manuals on the left (so you don’t have to search through application notes) and you can find the Help file, where you can look and see how the E5071C saves trace data:

http://ena.tm.agilent.com/e5071c/manuals/webhelp/eng/
Also, Wikipedia has a link to the Touchstone spec here:

http://ena.tm.agilent.com/e5071c/manuals/webhelp/eng/
4   Plotting Equations and Formatting Graph Objects

Microwave Office allows you to type equations into various documents, with a Mathcad-like look and feel.  From the Draw menu, you select Draw -> Add Equation (also Cntrl-e).  You can do this on a Schematic document or on an Output Equations document.  Creating either type of document is easy.  For a schematic document, right-click in the project manager tree on the “Circuit Schematics” folder and select New Schematic to bring up a new schematic window.  For an output equations document, right-click in the project manager tree on the “Output Equations” folder and select New Output Equations.

Let’s go back to our example where we just graphed LogMag S11 of MY_INDUCTOR.  Now let’s plot its Z-parameter, Z11.  Create another graph object.  On the new graph object, right-click and select Add New Measurement.  In the pop-up select to plot Z-parameters this time, and choose Im{Z11}.  Click the lightning bolt to update the graph.

But now let’s say that we would like to plot inductance from this Im{Z11} trace.  In order to divide through by frequency, we need to create an output equation.  Use Draw -> Add Output Equation to add an output equation to the Output Equations document.  Output Equations assign the result of a graph’s measurement, to a variable.  You can put both regular equations and output equations in the Output Equations document.  Regular equations are black.  Output equations turn dark green (but if you type the equation with any sort of syntax error, the equation will turn red).  Output equations are also different from regular equations in that when you right click on them, you’ll get a different type of popup dialog.  The output equation popup dialog will let you select from among your different measurements, for what you want to be a variable in your output equation.

If you want to make an equation that involves the frequencies captured in a network analyzer measurement session, you need to extract those frequencies from the .s2p data file, and then store them in an MWO variable.  Let’s take an example.  For the data file of S-parameter data we just imported as MY_INDUCTOR, you’ve plotted impedance of an inductor vs frequency, but now you’d like to divide every value by frequency in order to plot inductance vs frequency),

First, set up your measurement to use the document frequencies (as opposed to the Project Options’ global frequencies, or a SWPFRQ block’s swept frequencies.  It’s important to understand these 3 ways of choosing the frequencies for the x-axis.  See the section below on Selecting Frequencies for graphs.  The AWR training site’s videos also go over this in good detail.).  

To extract the frequencies from that data file into a variable, you do this in the Output Equations window:

EQ1 = MY_INDUCTOR:DB(|S11|)       <-- I created this by dragging my measurement into the Output Equation window (i.e. drag the Measurement from the project manager tree’s Graph document to the Output Equation window, release the mouse button, then click to place).  This is simpler than doing Draw -> Add Output Equation and then selecting the measurement in the resulting popup window.  However, this dragging method always gives a default name of EQ1, so you must change it to make it unique if you already have a variable named EQ1.

Click on the lightning bolt to run the simulation.  You always have to run the simulation in order to get Microwave Office to evaluate an expression.  After evaluation, EQ1 will be a vector of real values representing the magnitude of S11 vs. its frequency sweep.  (Note that the units of all equations use MWO’s base units, not the project units you might have defined in Project Options).

Then type this equation in your Output Equations document (do Draw -> Add Equation, or Cntl-e and then type the equation):

xvalarray = swpvals(EQ1)

...which applies the function swpvals() to the variable EQ1 which has the value of the measurement result:

swpvals() is a function which returns the frequency sweep data of its argument

Now, if you add another equation that is just “xvalarray:” (notice the colon here), the colon acts in a similar way to Mathcad and evaluates the variable (after you run the simulation again by clicking on the lightning bolt, or equivalently Simulate -> Analyze).  Then the vector of frequencies is displayed as the value of xvalarray:

xvalarray: {5e8,6e8,7e8,8e8,9e8}

Now you can add any equation you want to the Output Equations window and use this xvalarray when you need to, say, divide a vector of impedances by this vector of frequencies to get the inductance.

Play around with it and try it.

[image: image17.png]Ugtses 805310
Upgies 0805220
8 pseneveisn
il e puom s
il S epberes Y i ol
2l 4 e s and s
8 et
B S epsnctose Spws
@ 15 tepbarciose Spm St
4 egban S s
il e Yoo, s
5l Lo Y i o

= 105 et Capactos SmaChat
@ Opimr ot

= v

= Oupurics




We can do a similar thing starting from a schematic rather than from an .s2p file imported into a data file document.  Create a new schematic document.  Select the Element tab from the bottom of the project manager window and select an inductor from the Lumped Elements category.  The port and the ground symbol can be found from icons along the top of the AWRDE gui.  Wiring up the elements is simply ... just hover the mouse over a connection location and the cursor turns into a wiring tool. 

To continue the example, let’s say you made a simple schematic like this and then created a graph and plotted the impedance looking across this inductor (Z11).  Now if you want to add a second plot which is that impedance trace divided by each frequency, you would create these equations in your Ouput Equations document as shown below.  Then go to the graph, right-click and select Add New Measurement.  The Add New Measurement dialog box pops up.  Scroll down and select Output Equations.  Then at the upper right, select the source document for where your output equations are, and then select the equation variable you want to plot (Ideal_L).  
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After hitting the lightning bolt icon to run the simulation, the data for L gets displayed.  You can re-format the graph to make this new data be a new left axis.  Just right-click on the graph, choose Properties and in the popup, select the Axes tab.  Under the Choose Axis box, select “Left 1” and then hit the Add Axis button.  That will add Left2 and Right2 to the list:
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Now you can select the Labels tab and select Left2 and you can give the new y-axis a label (i.e. “(Henries)”.)  Hit Apply and a new axis is added to the graph.  However, both data sets are still on the first axis:
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To move the inductance data to the other axis, go to the Measurements tab and select what’s selected in blue below (Ideal_L data should be on the Left2 axis).  Hit Apply and now the inductance data is moved to the other axis.  The value of L is 5 nH, obviously, since that was the value initially on the schematic, but you could make a similar plot which started from measured S-param data, as discussed earlier.

Remember, you always have to define a variable before you can use it in an equation.

You can also put equations in the document in the project tree node named Global Definitions.  Then all schematics in the Project will get that global variable’s value.  (Note that in MWO, you never open more than one project at a time, so project scope is global scope.)

4.1   Understanding Selecting Frequencies in Measurements on Graphs

The screenshot below has a graph that had some measuements added to it already.  Then I right-clicked on the graph and selected Modify Measurement, and then chose the S21 measurement..  The Modify Measurement dialog box shows (in the red circle) that the freqs were chosen to come from the document level (denoted by the global variable FDOC).  You can change that and have the frequencies come from the project level by clicking on the right-pointing arrow (green circle):
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The screenshot below shows the choices which pop up when you double-click on that right-pointing arrow (note:  there’s sometimes a third selection if your measurement is coming from a schematic that has a swept-frequency element, but here the measurement is just coming directly from a Data File named ShuntShort).  You can see that there are two choices for where to get the frequencies for the x-axis.  “Document level” means the data file, ShuntShort (the frequencies that were saved in that .s2p file which were imported to ShuntShort).  “Project level” means the frequencies that were set in the Project Options node of the project manager tree at its top left (blue circle, below).  Right-click on that Project Options node and a pop-up appears, choose Edit to see what the Project Options were set to for this project:
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2.3. Organizing a Design
You can logically organize designs in the AWRDE.

+ Window-in-Window: You can place a view of a window into another
window.

+ User Folders: You can build a folder structure and put any item in
these folders.

2.3.1. Window in Window

The AWRDE allows you to place a view of an object into another object.
For cxample, in a schematic window you can view different graphs
showing the schematic simulation results. Windows can contain other live
schematics, system diagrams, graphs, layouts and 3D views. This
capability allows you to build views of a design. Items can be added to
Global Definition windows also.

To add a "window in window":

1. Make the target document (for cxample, the schematic or graph) the
active window.

2. In the Project Browser, click on the item you want to add to the
target document, then hold down the mouse button and drag the item
to the target document window in the workspace.

3. When adding a schematic window to another window, use the right
‘mouse button to perform this operation and display a menu on the
target window that allows you to add the schematic as a schematic, a
subcircuit, or as the layout (or 3D layout) view of the schematic.

Insert Schemati Here:

Insert Layout Here
Insert 30 Layout Here.
Insert SubciruitHere  CerlK.

Cancel A




Here the Project Options has set the frequency sweep to go all the way up to 10 GHz:

Note on most common mistake in MWO:  In the screenshot above, if you change the frequencies you also need to hit the “Apply” button.  Just hitting OK, won’t execute changing the frequencies.
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Now go look at the document level (the Data Files node in the project tree, right click on ShuntShort and select Options).  Note that at the document level, if you want, you can check the checkbox for Use Project Defaults, but if left unchecked, it will use the frequencies in the ShuntShort file you imported:

You can double-click on the ShuntShort data file to look at its contents directly and scroll down to the bottom.  When the data was captured from the network analyzer as a .s2p file, the frequency sweep on the network analyzer had been set with a Stop frequency of 4.5 GHz.  Clicking on the lightning bolt, to run the simulation, the graph shows the x-axis goes to 4.5 GHz, rather than the Project Options setting of 10 GHz.
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Now if you go back to the graph and do a Modify Measurement on S21 and switch to having the frequencies come from the project level (denoted by the global variable FPRJ):

Note, that the data only goes up to 4.5 GHz, so if the frequencies are taken from the Project Options which go to 10 GHz, how will the graph turn out?

In this case, MWO extrapolates the data.  You may not want that, or you may want it, but be aware of what the tool does.  It’s a good idea to keep the Status window scrolled to its bottom so you can see any warnings.  In this case, the Click for Help link takes you to the portion of the Help manual which describes this data extrapolation “feature”.
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5  Exporting Schematic S-Param Files (for Importing into Matlab)

Just as a network analyzer can save out an .s2p file, MWO can also save out an .s2p file for any schematic.  This can be useful if you want to work in Matlab.  Matlab can directly read .s2p files.

If you have an .s2p file that you saved from your network analyzer measurements, Matlab can read that in and graph it.  Similarly, you might want to create an ideal circuit’s S-parameters (model of what you measured) in MWO and export them to a .s2p file.  Then you can read both the model and the measurement .s2p files into Matlab, and do whatever computations you like in the Matlab environment.

In MWO, right-click on the Output Files document folder in the project tree and select Add Output File.  In the pop-up, choose Port Parameters:
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In the next pop-up, browse to the directory where you’ll want Matlab to find it, and select the format for the S-params (probably best to change the frequency units to Hz, so your Matlab code can be written in units of Hz).  This formatting information will get written to a header line in the exported .s2p file:
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Note that this file won’t get created when you click okay.  It merely gets set up.  You’ll see it added to the Output Files folder.  However, to actually get MWO to write out this new file, you have to click on the lightning bolt.  

You always have to click on the lightning bolt icon to get MWO to execute anything.  

The status window will update and say the file was written.  You can then open the file in either Matlab’s editor or any text editor:
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5.1  Matlab’s RF Toolbox

Matlab has an RF Toolbox with functions that convert between S and Y, Z, and ABCD parameters, etc.  Then you can read in .s2p files and plot out what you like:

[image: image34.png]



RF Toolbox has a number of other functions, most of which revolve around creating an rfdata object.  If you have a .s2p file, you create an rfdata object this way:
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This created an rfdata object named MyOpenData.  Now you can get all the properties and their values if you do a “get” call on this object handle, MyOpenData.

The Help documentation is too small to read on my machine.  Hit Cntl-+ to make the font larger.

To see all the functions available in RF Toolbox, search on “Matlab functions in RF toolbox”:
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6   Units in Functions and Equations in MWO

The second training module on the AWR site discusses how if you use a function in, say, an element (they use the function called “stepped” for the value of the swpfrq element) ... those functions assume you are giving arguments in base units of Hz, meters, watts, etc.  That is, even if in Project Options, you set the Global Units to GHz, when you give the swpfrq function its arguments, you have to type those frequency numbers in in units of Hz.

By assuming arguments to functions are given in base units, MWO gets around the problem which arises if you copy your schematic with its swpfrq element to another project that has different Global Units.  By this convention of assuming function arguments in base units, the function will return the same value no matter what project it’s in.

Also, if you put an equation on a schematic, let’s say you define a variable “my_ind = 1” and then you use that as the value of an inductor element ... the units get picked up by the inductor element (if it is in nanohenries, then my_ind will end up telling the element that the inductor has a value of 1 nH).  That is, my_ind is just a number, 1.  This can lead to problems if you move this schematic to another project which has different Global Units and inductance defaults to nH.  In that project, all inductor elements will come up with values in nH.  If you make its value be “my_ind” and you want to prevent confusion later, you can do this:

Go to Project Options -> Edit and select the Schematics/Diagrams tab.  Select the checkbox labeled “Dependent parameters use base units”.  This means that whenver you set an element’s value to a variable like “my_ind”, that element (and only that element) will have its units set to base units.  In this case, all inductors on a schematic that were given the value “my_ind” would have their units change from nH to H in their element text boxes.

Now if you add a swept-variable element, swpvar, and you want to give it the value my_ind, you have to type into the field for VarName, the character string “my_ind”.  Make sure you give it in quotes, because VarName expects a character string.  Where you have the equation myind = 1, that is the variable itself.

Also, the my_ind equation has to be local to this schematic (it can’t be up in the Global Definitions node of the project tree).  The swept-variable element itself also has to be local to the schematic it’s used in.  It can’t be up in Global Definitions either. 

The swpvar element has another field, “Values”.  The numbers you type in here are just that, numbers.  They are unitless.  The units are always picked up by the element itself.
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6.1 Syntax for Vectors in MWO

MWO has different syntax conventions than Matlab.  You can define a scalar like this:

foo = 1

If you want to make a vector, use curly brackets and commas:

foo = {1, 3, 5}

To index the second value, 3, do:

foo[2]:

The colon just signifies that we want to evaluate foo and return its second item (array indexing starts with index 1).
7   Tuning in MWO

In MWO, tuning is very simple.  You use only these two circled icons, the Tune Tool icon (a screwdriver) and the Tune icon (a slider).  First click on the Tune Tool and the cursor changes to a screwdriver, then select a component value on a schematic to turn it blue (see C = 1pF under ID=C2 below).  You have to have a schematic window selected for the Tune Tool icon to appear on the menu bar:
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Next you have to create a graph and add a measurement to the graph.  All simulations are “driven” by measurements on graphs (unlike ADS, where you set up data sets first, run simulations to get that data, and then make a graph.  In MWO, you don’t have to think about data sets, as the measurements you set up on graphs “tell” MWO what to simulate.)

To  create a graph, right-click on the project manager tree’s Graphs document node and select New Graph (choose rectangular or Smith Chart, etc. and click OK).  That will add a sub-node under Graphs in the project manager tree.  You can right-click on that sub-node, and select Rename Graph to change the name.

In the graph window that popped up, right-click anywhere on the graph and select Add New Measurement.  In the Add Measurement dialog, make sure to select the correct Data Source Name (drop-down at upper right) to select the appropriate Data Set (for graphing imported .s2p file data directly) or the desired Circuit Schematic (to graph, say, the port parameter data in the schematic shown below):
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Each measurment you add to a graph creates a sub-sub-node in the project manager tree.  You can change the measurement by right-clicking anywhere on the graph and selecting Modify Measurement.  This is a good way to copy a graph. That is, you can set up a graph’s axes and labels, the way you want them, then copy the graph, and in the duplicate graph just change the measurement to pull the data from a different data source.  Copying a graph is easy – you can drag and drop directly in the project manager tree.  Select the node in the tree for the graph you want to copy, then just drag it up a level to the node labeled “Graphs”, and that will make a copy.

Right-clicking on a graph and selecting Properties brings up a dialog that lets you set the axes limits and Labels for names for the x-axis and y-axis.  If you click on Left 1, under Axis, you’ll see the button below, Add Axis, ungrey.  If you click on that button, you’ll add another (rectangular, in this case) axis set below your graph (two graphs in one graph window now).
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Anyway, once you have a measurement set up in your graph, run the simulator by clicking on the lightning bolt icon at the top of the gui.  Now you can tune very easily by simply clicking on the Tune icon.

Now let’s say you want to tune the capacitors together.  You can add an equation (Draw -> Add Equation, or Cntl-E) and create a variable for the nominal value of the capacitors.  Put the equation anywhere on the schematic, myCap = 1 (the units will get picked up by the element that you give this value to).  Click on the value of each of the capacitors C1 and C2 and change each capacitors’s value to myCap:

[image: image40.png]6D Project

5] Design Notes
Project Options
{5 Global Definitions.
(& Data Files

558} Circuit Schematics

320m PTMFET

{3 Netlists
@l EM Structures.
3 Output Equations
(i Graphs
& Optimizer Goals
{2 Yield Goals
D Output Fles
Gl Data Sets
@ Circuit Symbols
(& Simulation Filters
(D Switch Lists
Wizards

{3 UserFolders

E

Elements | ] Layout

BSIM4

1D=M1
TYPE=N
VERSION=4:4

2o

1 4
S
< ss

Reading file C:\Users\aflynn\data\AWRwork\nbsimé.txt
Tdentified AWR model as BSIM4

setting model parameter TYPE to N, original value was 1
setting model parameter BINUNIT to 1, original value was 1
setting model parameter DARAMCHK to 1, original value was 1
setting model parameter MOBMOD to 0, original value was
setting model parameter CABMOD to 2, original value was
setting model parameter IGCMOD to 1, original value was
setting model parameter IGBMOD to 1, original value was
setting model parameter GEOMOD to 1, original value was
setting model parameter DIOMOD to 1, original value was
setting model parameter RDSMOD to 0, original value was
setting model parameter RBODYMOD to 1, original value was 0
setting model parameter RGATEMOD to 1, original value was 0
setting model parameter DERMOD to 1, original value was 1
setting model parameter ACNQSMOD to 0, original value was 0
setting model parameter TRNQSMOD to 0, original value was 0
setting model parameter TNOM to 27, original value was 294.
setting model parameter TOXE to 1.15E-009, original value wi
setting model parameter TOXP to 9E-010, original value was |
setting model parameter TOXM to 1.15E-009, original value w:
setting model parameter DTOX to 2.5E-010, original value wa:
setting model parameter EPSROX to 3.9, original value was 3
setting model parameter WINT to 5E-009, original value was |
setting model parameter LINT to 2.7E-009, original value wa:
setting model parameter LL to 0, original value was 0
setting model parameter WL to 0, original value was 0
setting model parameter LIN to 1, original value was 1
setting model parameter WLN to 1, original value was 1
setting model parameter LW to 0, original value was 0
setting model parameter WW to 0, original value was 0
setting model parameter LWN to 1, original value was 1
setting model parameter WWN to 1, original value was 1 i

Pl I I [ A

orooomo

Status Window
By CopyAll| X X





Now (with the schematic window selected as active), click on the Tune Tool icon and then make myCap = 1 turn blue by clicking on it.  Once an equation is turned blue, you can tune that equation.  Notice that the variable myCap is now added to the Variable Tuner window:
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As you move the tuning slider, MWO repeatedly re-runs the simulation and updates the graph.  Tuning is gone over in detail in the AWR training module videos.  You can change the min and max ranges of each tuning variable, revert to the starting setting, etc.

[image: image42.png]AWRDE Help_

Hide | locate  Back Print  Options.
{Capacitance] a7
Cortents | ipgex | Search | OV 4, intrinsic charge.
Wicrostip - a0,
5 (3 Norinear cbs (Capacitance) 3
5] Angelov HEMT Model: ANGELOV OV’ intrinsic charge.
(5] Second Generation Angelov (Chalmers) Model: ANGELOV2
[5] @bsolt) dvanced Compaible Angelv HEMT Hode: ANGELOVZC 20,
[5] Advanced Compatbe Angelov HENT Model: ANGELOVZC2 cdg (Capacitance) P
[5] AURIGA_M5: AURIGA_E OV'¢ intrinsic charge.
[5] BSIM3 MOSFET odet: BSIV3 FT)
21 (Obsolete) Berkeley BSIM3V322 MOSFET ver. 322 BSIM3V322 cdb (Capacitance) -]

5] (Obsolete) BSIM3 Ver. 3.2.2 P-Channel MOSFET Model: BSIM3V322P

[5] BSIM4 MOSFET odel: BSIV4 OV, intinsic charge.

[£) Curtcs FET Modl 1V Oniy): CFET a9,

[5] Chimers Heterostructre Barrer Varactr Diode Modsl: CHAL_HBV cdd (Capacitance) o

5] (Obsolee) Cutice Cubic Noiinear FET Hodsl: CURTICE. OV | intrinsic charge.
5] Curtice Quadratic FET Model: CURTICE2 .

15 Avercad e Guosasc FET o it Nose: CURTICEZADY 30,

[5] Cuti G Narner FET Hodel:CURTICES cds (Capacitance) 57

[5] O St and RF Open: DCSHORT OV, intrinsic charge.
5] Simple Diode Model: DIODE

[5] Sl Diode Modsl: DIODET 29,

15 Pryscal Diode Mocek: DIODE2 csg (Capacitance) 7

[5] EEBIT2 Bl duncion Tonsior Model - EEBIT2 ¢ inrinsic charge.
5] EeHewT. E2HeuT 30

[£] Field Effect Transistor Noise Model (Pospieszalski |s): FETN csb (Capacitance) s

21 Fuji FET Model: FuuIl

[£] GummelPoon NN BUT- GBI OV intrinsic charge

[£) Gummek Poon 3-Teminal NPN BJT- GBJTS 20

[5] Gummetoan 3 Teminl NP BJT-GBJT3_PNP csd (Capacitance) -

[5] Gummek Poon PN BJT-GBJT_PNP OV | intrinsic charge.

[5] UCSD HBT Hodel HBT d

12 sl UCSD HBT Nocel- HBT LCSD 30,

3 v T il HBTFA css (Capacitance) 5

[5] HCUM Level 0 BT Hodel: ICUM_LO OV's , inrinsic charge.

[E] Obsolete) HICUM Level 2 NPN Transistor: HICUM_L2 N -

B e 22 1T res e 20 id (Capacitance) Drain-substrate junction capacitance
(Obsolete) HICUM Level 2 PNP Transistor: HICUM_L2_P i P

B e e e HCNLL2.5H s (Capacitance) ‘Source-substrate junction capacitance

[5] @bsolte) HCUM Level 2 PP Tansstorwith Sl Hecting HICUNL2_SH_P owr (Power) Dissipated power

[5) Phiips JUNCAP Model: JUNCAP

[5] Modfied Materka FET Modsl: MATRK
Emﬂ;ﬂmﬁ M:d M(:ASNEM MET_LDMOS Implementation Details
21 Phips Level 1102 MOSFET Model: MOS11

5] i Lovl 3100 HOSFET Modst HOS31 ‘The TYPE parameter controls whether the device is N, or P channel, which is reflected by the device symbol. The NFLAG and
e e 3G oSrT b o COMPAT parameters are unique to AWR's implementation. The NFLAG parameter allows yot to tum the device noise on or off.
2 s S et HOSPET Mo 105 COMPAT, the compatibility sclection flag, takes three different valucs: HSPICE, AWR, and SPECTRE. The HSPICE and
D o e s HOSNT& Spectre values emulate HSPICE and Spectre implementations of the BSIM4 model, respectively. Parameters without default

5] SPOE Lo 1N HOSFET: MOSNI_#A values listed in the previous table gt their values from formulas. In many instances, the provided default value depends on the

[5] SPICE Lovel 1 3-Temminal N MOSFET: HOSNTA L compatibility flag sctting. The VERSION parameter allows sclocting between versions 4.4 and 4.5 of BSIMA4.

B thentoto) SPIE | mund 2 N MOSEET Medal- MOSND




8   Window in Window Feature

Let’s say you have several different graph windows that you’d like to watch change all at the same time.  Instead of having lots of different windows open, MWO lets you organize things more efficiently with the Window in Window capability.  Basically, you can have a schematic window selected as active, then in the project manager tree, drag a graph object over to the schematic.  The cursor changes to a cross-hair with a hatched box next to it once you stop dragging.  Now click on the schematic and drag a box.  You can add different graphs, for instance a rectangular graph and a separate Smith Chart graph (they normally can’t be created in the same graph object, but you can put two different graph object windows inside a schematic).  Now if you click on the Tune tool, you can tune your inductor or your capacitors and see both graphs change.  That is, these objects are live.
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9   User Folders

One thing that is also very useful is the concept of User Folders, which is the last node at the bottom of the program tree.  User Folders are basically a customized folder structure of the project manager tree above it.  You can right-click on the User Folders node and select Add New Folder to create your own hierarchy of folders.  Then you can select any item, say a schematic or a graph, in the project manager tree and drag it to one of your new user folders.  Items dragged to the User Folders hierarchy are not copied, rather the User Folder section is more like a set of pointers to the original items, so that you can organize things they way you want them, while leaving the original project manager tree in its unaltered form.

You can name your sub-folders under User Folders anything you want (right-click on a new user folder and select Rename).  If you try to delete an item you’ve put in a user folder, you’ll be prompted to just remove the item from your user folder vs. actually deleting the item from the entire project.  If you change something on a schematic that you’ve added to a user folder, note that you aren’t working with a simple copy of the schematic.  You’ll notice that if you close the schematic in your user folder, and then go to the project tree and open the original schematic there, the change has also been made to the original.

If you’ve made two user folders and you placed a schematic in one of them, you can move that schematic to the second folder simply by dragging it there in the User Folder tree.  Similarly, you can “copy” (think of it as copying a pointer) that schematic from your first user folder to your second by holding down Cntl+dragging it to the second folder.  Now that schematic will be in both user folders.  Again, adding an equation or making some change to any of the 3 places this schematic now exists (in your two user folders and in the original project tree) will change the schematic in all three locations.

The nice thing all of this enables, is that you can disable an entire folder:
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With a folder disabled, if you hit the lightning bolt, the simulator will run on all graphs except those you just disabled.  By selectively enabling, disabling or toggling the enable state, you can run just the simulations for the graphs you’re working on (saves time if some simulations are long).

More details on these project features are in the Help in Section 2.3 of the AWRDE User Guide:
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10   Optimization

There is an optimizer built into MWO.  Open the example project, linear_example.emp, to see how it works.  The discussion is in the Help under:

Getting Started ... Using the Linear Simulator ... Adding Optimization Goals 
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Basically, with a schematic selected as the active window, you run the optimizer with:

Simulate -> Optimize

...in this example, the variables to optimize on will be the two equations (for IND and for CAP) and the capacitor C2:
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Simulate -> Optimize will bring up the Optimizer window with the tab at the bottom left (also called Optimizer) selected.  Click on the next tab, for Variables.  Then in the column titled Optimize, check the boxes for IND, CAP and capacitor C2:
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Next, go over to the project manager tree to the node named Optimzer Goals.  Right-click and select Add Optimizer Goal.  
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The New Optimizer Goal will come up listing all the measurements you’ve added to all your graphs.  Select a measurement and then set the goals for how you’d like that curve to end up.  You can click on the goal objects already set up in this example to see how it was done.  The goal shown here is to have |S(1,1)| be less than -17 dB over the range from the project’s minimum frequency up through 500 MHz.  The second and third goals are set up similarly.  Both of those goals put constraints on |S(2,1)|:  1)  make |S21| be less than -30 dB over the range from 700 MHz up to the project’s maximum frequency, and 2)  make |S21| be greater than -1 dB over the range from the minimum project frequency up through 500 MHz. 
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If you hit OK and click the lightning bolt, the optimizer runs and updates the graph.  You can set the values of IND and CAP back to some other values and disable the Optimizer Goals (right-click on that Optimizer Goals node in the project tree and disable all goals).  Now click on the lightning bolt and you’ll get some graph that’s un-optimized.

[image: image54.png]O APLAC
Coplanar

O General

-~ Interconnects
4 Linear Devices

4 Lumped Element
MeasDevice
223 Microstip

24~ Nonlinear

U PRELRELEASE
D Ports

- Simulation Control
& Sources
=] Stripline

=3 Substrates

= Transmission Lines
& Waveguide

o Subcircuits

X Libraries

Models
IBFGI03W

7 BFGA03W> NXP_BFGA0W.
schematic 1

| BFG403W (HSPICE Netlist)

[* Filename: BFG403W.SP
.SUBCKT NXP_BFG403W 1 2 3
L1 2 5 1.1E-09

L2 14 1.1E-09

L3 3 6 0.25E-09

Ccb 4 5 2.0E-15

Cbe 5 6 80.0E-15

Cce 4 6 80.0E-15
1.458-13
1.458-13

25

19

6 BFG403W

amawma

BFG403W NEN

5.554E-18
145
0.9934
=31.12
35.75E-03
3.535E-14
3
11.37

0.985




Now run:

Simulate -> Optimize

... to bring up the Optimizer window.  Make sure the bottom left tab, Optimizer, is selected.  Choose an Optimization Method at top left (Random, Local) and a number of iterations (5000).  Re-enable the Optimizer goals, and then hit Start.
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After you hit Start, the Optimizer runs and shows its progress in the iterations progress windows.  When it finishes, it updates the schematic with the final optimum component values for IND, CAP and capacitor C2.  

More details the Optimizer’s algorithms are in Section 2.6 of the Simulation and Analysis Guide.
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11   Adding a Spice Model to an MWO Project

There is an AWR Knowledge Base article on importing Spice model and/or sub-circuits into MWO here:

https://awrcorp.com/download/faq/english/questions/import_spice.aspx
This is its main point – what AWR expects.  For any Spice model you get, say from a vendor’s web page, you have to massage them in a certain way:  if the file has more than one .model section, make separate files for each model.  Change the extension on the file name to .sp if it’s something else.  If the file has a .subckt section and a .model section (e.g. the .model for parameters of certain transistor and the .subckt for the package model around the die), make sure there aren’t any syntax errors, etc.  For instance, MWO expects transistor nodes to be ordered gate-drain-source or base-collector-emitter, so edit the file if they aren’t in that order.  Traditional Spice files order the nodes as drain-gate-soure and collector-base-emitter, so you often have to switch the first two nodes.  (Note:  the fourth node is the substrate.  If it is omitted, Spice/MWO assume it is connected to ground.)

This is the gist of the Knowledge Base article mentioned in the previous paragraph:
Model format Guidelines: 

1. Each model must be stored in a separate file in order to be imported and used. 

2. A top level subcircuit macromodel (.SUBCKT) can be in the same file as the hierarchy of macromodels below it, but the .SUBCKT definitions cannot be nested inside one another. 

3. Models are easier to import if their filename extensions are .sp for HSPICE models, and .cir for PSpice models. 

4. Native HSPICE subcircuit models for transistors should be edited to make the order of the nodes: gate-drain-source (-bulk), or base-collector-emitter (-bulk). This is the pin order on the transistor symbols shipped with the AWRDE. When 3- and 4-pin subcircuit models are translated (not native), an option is offered to swap the first two nodes automatically. 

5. HSPICE and PSpice handle node names differently. To avoid translation problems, each node name in a subcircuit should be purely numeric or begin with a letter; and it should not contain non-alphanumeric characters. 

6. The translators import any mathematical expressions as they are. Some of the less common functions (e.g. if-then-else) may need to be edited manually after translation, to make them compatible with AWR DE. 

7. Behavioral elements and controlled sources, other than SPICE2G6 compatible linear and polynomial ones, are not translated. 

In the screenshots below, I’ve copied two .model Spice files into the AWRwork directory.  These were created by an AWR University tech support person, who took the ptm32nm_hp.pm Spice model file which I downloaded off the web from the ASU PTM site.  He said the best way to read a new model into an MWO element is to use a script they have provided under the MWO desktop menu bar’s “Scripts” menu.  First, make a schematic window active, then run the script:

Scripts -> Models -> Circuit_Model_Parameter_Read

Note that Spice models files have a .model line, while Spice netlist files have a .subckt line (and optionally netlist files of a sub-circuit can have a .model line in addition).  This script is for reading in model files that solely have the .model info.

The ASU PTM site had the file with two models in that file (i.e. no .subckt line), a model for nmos and a model for pmos.  The AWR tech support person said that for the script to work you have to have the model name in the parameter file you want to read in, be the same as an MWO model.  In MWO’s case, they have a BSIM4 element with the model name of BSIM4, so he edited the original file I sent him, saving it into two separate files, one for nmos and one for pmos.  He re-named the model name in each file so that it now says “bsim4”, which is what MWO needs in order to understand it.  He also had to add a field type=n or type=p (for the nmos or pmos version of the bsim model).  The two new files are named:

nbsim4.txt

pbsim4.txt
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Then go back to the MWO desktop and from the menu bar, select:

Scripts -> Models -> Circuit_Model_Parameter_Read

This dialog window pops up.  I chose:

nbsim4.txt
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The script runs and these windows pop up:
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Clicking okay, then tiling the windows vertically, you can see that the script put the element that goes with the bsim4 model (the element’s name is BSIM4 and it figured out that it needed to use the NFET symbol) onto the active open schematic:
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This was the request question to the University Support page I submitted on 9/9/12 and the next day I got an answer:
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Here’s some info on the BSIM4 model (got to it by selecting the element on the schematic and hitting Function-F1):
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To see the transistor curves for the BSIM4 ptm model, you can look at an example file that comes with MWO.  Do:

File -> Open Example

...and search for FET_Characterization.emp
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It looks like this.  Click on the lightning bolt and it simulates and plots the graphs (plots the ones that are enabled, not greyed out):

Then if you select the icon connected to the gate and drain of the FET and hit Function-F1, the Help opens to the page for the IVCURVE icon:
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Then you can go look at how the example set up the graph.  Right-click on its graph and select Modify Measurement.  The Modifiy Measurement box that pops up shows you how the measurement in the graph has been set up.  They had selected the Measurement Type under the Non-linear category, called IVCURVE.  For the Simulator Type, they used APLAC DC.  The data source is that schematic named IV.  For the x-axis, they used the IVCURVE.IV1.SWP voltages and they chose Plot All Traces for IVCURVE.IV1.STEP. 

So you can do a similar thing for the BSIM4 fet with the ptm model:
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However, the simulator gave an error:
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I asked AWR tech support about this and they replied:

“Unfortunately the script is not perfect and sometimes some parameters come in wrong. This is especially an issue if the file being imported has different units on some parameters. After importing, it is always good to go to the 'Element Options' page and look at the properties.  In this case, you will see that the TNOM is -246.15 degrees Celsius instead of the 27 it should be. Changing that parameter to 27 allows the simulation to run.”

What he meant by “Element Options” was the dialog box that comes up when you double-click in the schematic on the FET element:
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The parameters shown are only the primary parameters.  Click on the Show Secondary button and you can see all the BSIM4 params that were read in from the model file, nbsim4.txt:
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For some reason, TNOM got set to -246.15 (it was 27 in the nbsim4.txt file and the import process log showed 27).  The script is not perfect.  It set TNOM to 27 K instead of 27 C.  I changed the -246.16 number in the Value box to 27.  Now the simulation runs:

Also, the awrcorp.com site has a page for a University Forum, and I found this post there at:
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http://univ.awrcorp.com/entries/168344-importing-a-cadence-spectre-model
Here’s another Spice model off the web that had to be fixed up before it could correctly be read into MWO.  This is the NXP/Philips BFG403W in an SOT343 package.  Their web page gave it in this form:
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Alarge number of simulation methods are supported in Microwave Office including

« Linear simulation: inear simulation is used for circuits created from only linear elements (elements whose response is
not a function of the magnitude of the voltage across them). Common linear analyses are:

« AC analysis which produces a transfer function of output voltage vs. input voltage
+ S-parameter analysis which produces a response of output power vs. input power
« Nonlinear simulation: nonlinear simulation is used for circuits containing nonlinear elements such as diodes and
transistors and include:

« Transient (spice) analysis is a method which computes a DC solution for the circut and then simulates the
circut as time advances computing the current (and voltages) of each node in the circuit at each point in time.

+ Steady-state (harmonic balance) analysis is a method that computes the steady-state response of a nonlinear
circuit.

Al of these methods are available in MWO depending on what stimulus you add to your circut and what measurements you add
to your graphs. You can search for the simulation method in the examples to see how to setup simulations for each method.




It gave an error when I read it in (the script is for reading in a file that has only the .model information).  There is some information in the AWR Knowledge Base about reading in Spice files here, but I didn’t think it was very clear:

https://awrcorp.com/download/faq/english/questions/import_spice.aspx
I asked AWR tech support and they massaged the file in a text editor to make it look like the screenshot below.  They said they had to do this because there were some mistakes in the file:

1) Change the file extension to .sp
2) add a .ENDS (end of subcircuit) like after the Q1 line
3) change the Q1 line to use the name of the model, which is BFG403W not NPN
4) change the subcircuit name to be different from the model name. This is not required but makes telling things apart much easier.  The subcircuit name is now NXP_BFG403W.
When a Spice file has more than just .model information, like as in this case it also has Subckt information, we don’t use the script, Circuit_Model_Parameter_Read.  Instead, we get this type of Spice subcircuit netlist into MWO by right-clicking on Netlists in the project manager tree and then selecting Import Netlist.  Once it’s read in, it shows up in the Element browser under the Subckts node.  Actually, schematics also show up under the Subckts node too (because you can build hierarchies of schematics and netlists, so a schematic can be a sub-circuit in a hierarchy).
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So go to the Element browser (tab at the bottom of the project manager tree) and drag the sub-circuit, NXP_BFG403W, onto a schematic.  

It shows up as a rectangle with 3 ports numbered 1, 2 and 3 because that’s what the first .Subckt lines says it has.  If you double-click on an element in a schematic, you bring up its Element Options dialog.  Toggle the Hide/Show Secondary parameters button to see all of the parameters.  Or you can click on the up-arrow or down-arrow icons in the menu bar to push down into the sub-circuit’s hierarchy (where you will see its netlist).  You can change the symbol to a transistor symbol by selecting the tab named Symbol in the Element Option dialog.
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If you select a BJT symbol, then that will get placed on the schematic instead.  Now add an IVCURVEI element (from the Element browser -> MeasDevice -> IV and wire it up and set the sweep parameters.  Then create a graph and add a measurement (a simulation will only run if you create a graph and add a measurement to the graph).  

Actually, this simulation below didn’t work:
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I had to wire it up like this to get the simulator to run at all (but this setup doesn’t make any sense):
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There’s an example that shows how to get started with BJT measurements and it has its BJT wired up with the way that makes sense (base currents being stepped and the x-axis being the swept voltage, Vce):

File -> Open Example -> nonlinear_example.emp

You can see a variety of graphs and measurements that they’ve set up in this example:
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The problem with the imported BFG403W model is that I didn’t edit the order of the nodes, which have to be switched to the base-collector-emitter format.  The file needs to be edited like this:  (The first two nodes of the Q1 line had to be switched from 5 4 to 4 5.  Then all the lines above that line had to have every 5 switched to a 4 and 4 switched to a 5.  The sub-cirucits nodes 1 and 2 also have to be switched to 2 and 1.)

12   iFilter Design Tool

Microwave Office comes with a filter design tool called iFilter.  It can be found at the bottom of the project tree under Wizards.

The AWR TV Downloads site has a video on iFilter:

http://www.awr.tv/Downloads/
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You can enter the type of filter, add markers, add specs, etc. etc.  It will generate a circuit topology with the necessary values and then you can send it all to a Microwave Office schematic:
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There’s plenty of info on how to run iFilter in the Help’s User Guide for AWR Design Environment:
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When you run the Wizard, select what you need, you can then close out by doing one of two things.  If you click OK, creates a new sub-document in the project tree under the iFilter Wizard for this new filter design item you just created.  If you click on Generate Design, it does the same thing, but also creates schematic pages and/or graphs, as necessary.  Of course, you can also just click Cancel and not save your filter design item in the project tree at all.

13   Impedance Matching Utility

iMatch, a sub-tool of the iFilter module, does impedance matching in Microwave Office:
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Since impedance matching circuis are basically subsets of bandpass-filter circuits, the iMatch functionality is inside the iFilter wizard.  With a project open and the Project Browser shown on the left of the MWO desktop, scroll down to Wizards and double-click on the iFilter Filter Wizard.  A window opens, titled iFilter – Lumped Element Filter.  Click on the button that says Lumped Element at the upper left and in the pop-up dialog, select Bandpass Filter.  Then in that pop-up window under Main Filter Type, select Impedance Matching Network:
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After hitting okay, a new pop-up window appears, titled Matching Terminations:

[image: image88.png]Project Options
56 Global Definitions
& Global Definitions.
- Data Files
“* CAPSERIES
“3* SHUNTSHORT
“3 THRU
“3* ZEROSERIES
“G* ZEROSHUNT
Circuit Schematics
PreLab Inductors
{3 Netlists
EM Structures
-6 Output Equations
&) PostLab Equations
5 PreLab Equations
-G Graphs
5] 01_THRU_Sparam plots
5 02, THRU_Vparam plots
2 03 THRU.)
{2 04_THRU
{2 05_THRU thrul.
531 06_SHUNTSHORT.Sparam_plots
53] 07_SHUNTSHORT Vparam plots
{2 08_SHUNTSHORT_Y_pi_model
{2 09_SHUNTSHORT _ssCin_and_ssCout
{2 10_SHUNTSHORT ssL.
53] 11_ZEROSERIES Sparam plots
53] 12_ZEROSERIES Vparam_plots
{2 13 ZEROSERIES_Y_pi_model
{2 14 ZEROSERIES zserCin_and zserCout
{2 15_ZEROSERIES zserl.
{531 16_ZEROSHUNT_Sparam plots
{531 17_ZEROSHUNT Yparam_plots
53] 18_ZEROSHUNT_Y_pi model
{2 19 ZEROSHUNT_zshntCin_and_zshntCout
{2 20_ZEROSHUNT zshntl.
53] 21_CAPSERIES Sparam plots
53] 22 CAPSERIES Yparam plots
{2 23 CAPSERIES Y_pi_model
53] 24_CAPSERIES capserCin_and capserCout
53] 25_CAPSERIES capserl.
5[ 101 PreLab Inductors
PreLab Inductors{Z(L 1)
PreLab EquationsEqn{deal L)
& Optimizer Goals

Yield Goals By CopyAll X X
lﬂwﬁmm & Lavout| T

(21| PreLab Equations
Ideal_Inductor_Impedance = PreLab_Inductors:|Z(1,1)]
xval_fregs = swpvals(Ideal_Inductor_Impedance)
Ideal_L = Ideal_Inductor_Impedance/(2*_PI*xval_fregs)

Ideal_L: { 5e-9,5e-9,5e-9,5e-9,5e-9,5¢-9,5e-9,5¢-9,5¢-9,5e-9,

Rectangular Plot Properties

Markers | Humeic | YieldData

dues | Tices | Fomat | Labels | Foris | Messuemens

Limits
[Dautolmts  [iogscale

Subely, step

&5 101_PreLab Inductors

iz,
PreLab_inductors
|-=- [Ean(deal Ly
PreLab Equations|

ETTE) 3nfo (18)

w»





There’s a video about the iMatch utility on AWR TV:

http://www.awr.tv
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14   TXLine Utility

TXLine is a free utility from AWR which can be downloaded separately from the AWR Design Environment but is also available from the Tools menu in Microwave Office.  It’s similar to the utility in Agilent’s ADS software (that utility is called Linecalc).  From Microwave Office, you can run TXLine from:

Tools -> TXLine

[image: image90.jpg]



15   Scripts in MWO
From the Scripts menu in Microwave Office you can run scripts that have already been loaded during installation.  You can look through the installation’s Scripts sub-directory to see what’s there (going to Help -> Show Files/Directories and double-clicking on the Scripts folder will cause a new Windows Explorer to open at the Scripts folder).  There are more Scripts on the AWR web site also:
https://awrcorp.com/download/faq/english/scripts/scripts.aspx
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...which looks like this:

For info on writing your own scripts, there’s a Wiki on the AWR site, here:

https://oldwiki.awrcorp.com/public/scripting/doku.php
There is some training material for a course that AWR teaches on scripting, here:

(p. 99 has info on adding functions for Output Equations)

https://oldwiki.awrcorp.com/public/scripting/lib/exe/fetch.php?media=scripting.pdf
You can download any of thee scripts (which are Visual Basic .bas programs).  All you need to do is store them in your ScriptsUser sub-directory and they will appear in the Scripts menu and be available for all projects.  You have to re-start Microwave Office though, after you add a new script.

15.1   Script for Copying Graphs and Design Notes to a Word Doc

The AWR web page script called “Copy All Open Windows in Project to MS Word” looks useful.  If you download it, unzip it and copy the extracted .bas file to your the AWR installation directory’s sub-directory named Scripts, you can execute it by selecting:

Scripts -> Global Scripts -> Copy Design to Word

That will open a new Word document and copy over any open graph windows.  It also copies over any notes you’ve written in the Design Notes document (whether or not you had the Design Notes document open):
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The new Word document looks like this:
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3%
s2pfile

'Inductor_ckt.s2p'

%% Read in a .s2p file (set the Matlab path first).
% An s2p file gives, for every freq, S11 S21 S12 & S22 in one of 3 formats
% (real/imag, mag/ang or dB/ang). A header line in the file says which.

% RF Toolbox has the functions, sparameters() and

% yparameters(). Both take a .s2p file for an argument, and create an

% object from which you can extract the S or Y parameters (and also the

% list of frequencies), respectively, into a Matlab handle object. The

% rfparam() function enables you to extract any of these (e.g. S11 S21 S12
s
s

or §22 from the S-param object ... or Y1l ¥21 Y12 ¥22 from the Y-param
object.
20 = 0;
S = sparameters(s2pfile); % Create a handle for this S param object
freqs = S.Frequencies; % Returns a vector of all the fregs (same for S & ¥ ¢
omegas = 2*pi*fregs; % Convert this vector of all the sampled fregs to ome
s11 = rfparam(s,1,1) % Returns S11 as a vector of complex numbers
$S21 = rfparam(s,2,1); % Returns S21 as a vector of complex numbers
5%
figure;

subplot(2,1,1);

plot (fregs, 20*logl0(abs(s11)));
ylabel('|sil] (dB)')
title('Magnitude and Phase of S11 and S21');

subplot(2,1,2);
plot(freqgs, (180/pi)*angle(Sll)); % angle() returns radians. Want degrees.
ylabel ('s11 (deg) '
xlabel ('Frequency (Hz)')





15.2   Other Useful Scripts

It’s likely scripts have already been written for a repetitive task you find yourself doing.  For instance, there’s a script to search for and replace variables in equations:

Scripts -> Equations -> Replace_Variables

Already mentioned was the script for reading in a Spice model parameter file:

Scripts -> Models -> Circuit_Model_Parameter_Read
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For instance, here’s another example that it worked perfectly on ... downloaded the BFG403W spice model to a folder and then ran the script, browsed to that file, and the script read in the file and placed a GBJT element on the open schematic page.  Selecting the element and then hitting F1 brings up the Help page for a Gummel-Poon NPN BJT.

The End
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